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DT MAX BASICS 

In the following paragraphs, we will see the basic features of DT Max.  

 

SPLASH SCREEN 

When you open DT Max, the first screen that will be presented to you is the Splash Screen. 

 

 

You must first select a folder that will house the files of your Client Database. You may select your Database 

location by clicking the browse icon. 
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You may now enter a Username or Accountant ID. A user Password may also be added. We will discuss user 

priviledges and passwords in the Security System chapter.  

 

 

Select the Tax year you wish to access by choosing the appropriate year from the scroll-down menu. Once in the 

program, you will still have the option to rapidly change taxation years without having to restart DT Max. 

 

 
Next, select the DT Max product you wish to load. In this case, we will select T3. 
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Recently accessed clients will also be listed on this screen. You may access them directly by double-clicking the 

desired client. DT Max will load the Client List screen with the selected client highlighted. 

 

 

The Splash Screen also provides many useful links such as the knowledge base, online video tutorials, and the 

DT Max support page. 
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Once you have enter all the relevant information, run DT Max by clicking on 
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CLIENT LIST 

 
When you start DT Max, the first screen you will enter is the Client list. The Client list displays all the client files that 
are currently being processed as well as the client files that have been carried forward from one year to the next. 
 
Certain basic information of every clientôs file is displayed directly in the Client list. For example, you can view the 
clientôs number, trust name, account number, year-end, Processing Status, etcé All this information is displayed 
directly in the Client list. 

 

 

Personalizing the Client List 

In order to personalize the Client list, go to the Preferences Menu, and select Client List Settings. 

 

 

You can also personalize the Client list by clicking on the Customize Client List icon. 
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Sorting the Client List 

Certain columns of the customer list can be sorted such as the client 
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A window will appear to configure the new trust. You can change the client number that is automatically assigned 

to the new trust. 

 

The SmartStart input assistant is a tool that will allow to add keywords in the Data Entry screen of your client file. 

More details on this tool will be provided in the Data Entry portion of this document. 
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Finding clients within the Client list 

To find clients t
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Manual Entry of keywords 
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Keyword Help Index 

 
To access the Keyword Help Index, click on the Keyword Help Index icon, or press F8. 
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When you click on the Jacket tab, DT Max presents you with all the line numbers that are located on the tax return 

for both the Federal and Quebec returns. Click on a specific line number, and DT Max will present to you a list of 

keywords you can use to enter an amount on that specific line. Double-click on the keyword you need, and DT Max 

will add it to the clientôs Data Entry.  

 

 

When you click on the Form 
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Fields marked with an asterisk  

 
Fields marked with an asterisk require mandatory or important information.  
 
All fields with a red asterisks (*) are mandatory fields. The field cannot be left blank, because it will prevents the 
calculation of the tax return. 
 

 
 
DT Max will generate an error message marked with a red circle in the Error and warning messages window. 
(See section Errors and Warnings messages)  
 
Fields marked with blue asterisks (*) requires an important information for the production of the income tax return. 

 
 
If information is missing, an error message will appear in the Error and warning messages window. (See section 
Errors and Warnings messages)
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Error messages that are in yellow are warnings that do not prevent you from calculating your clientôs tax return.  

 

In order to correct an error message, simply double-click on the message itself, and DT Max will direct you to the 

keyword that you have to complete or correct. 

 

Keyword Groups 

Most keywords entered within DT Max are part of what is called a Keyword Group. The keyword group starts with 

a keyword that is in bold, which is called the Main keyword of the group. It is delineated by a bracket to the left of 

the keyword group. 

 

 

To the left of the Main keyword, you have the Expand icon. Click on this icon to expand or close a specific keyword 

group.  
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Expanding a keyword group allows you to see the Secondary keywords within the group.  

A keyword group has been expanded when the bracket delineating the group is jagged. 

When completing a keyword group, you must always complete the Main keyword of the group before 

completing the Secondary keywords. If you do not follow this rule, DT Max will indicate an error message that 

will prevent you from recalculating (first element of the group cannot be blank). 

 

Keyword explanation (functionality) 

When encountering a confusing keyword, there are several ways of finding out the functionality of the keyword. 

Hover your cursor over a specific keyword, and DT Max will give you a brief description underneath the cursor, that 

describes what the keyword does. 

 

If you are already on the keyword (highlighted in yellow), look at the bottom task bar of the program. DT Max will 

give you a brief description of the functionality of the keyword. 

 

A more detailed way of finding out the functionality of a specific keyword is to right-click on the keyword, and select 

Help for this keyword. You can also press CTRL-F8 on your keyword. 
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A new window will appear, giving a more detailed explanation on the functionality of the keyword and, if relevant, 
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In order to see the source keywords to use for a specific field that is currently blank, simply double-click on the 

empty field or right-click the field and select Source keywords. 

 

 

A new window will appear 
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Printing the tax return 

Once you have verified the tax return, you are now ready to print. In order to print the entire return or perform what 

is called Production printing, click on the Production printing icon. 
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Below, choose which versions of the tax return you want to print: the Production or the Plans (Plans will be 

discussed in a later chapter) 

 

 

On the right, under Step 2, choose which copies to print. You can print all destinations from the Forms Manager or 

select the specific ones you want to print (Forms Manager will be discussed in a later chapter). 

 

 

You may also choose to print a selection of pages rather than doing a full production printing. To print selected 

pages only, click the Select pages to print icon. 
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In the Forms printing window, select the appropriate printer and number of copies to print in the Printer section. 

 
 

In the Select pages section, all relevant forms for your client will be listed. Select the page(s) you wish to print and 

click Print. 

 

Tip: You may choose to select the pages one at a time by holding down CRTL on your keyboard and clicking the 

corresponding pages from the list. 
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PREFERENCES MENU 

The Preferences menu is the place where you can setup DT Max to perform automatic tasks for you. In the DT 

Max Basics section, we will see the items you should setup at the beginning of every year before starting any files. 

 

Identification 

The Identification section is the place where you will enter your identification information as a tax preparer. DT Max 

will automatically complete the relevant authorization forms for all your clients in the Client List. 

In order to set this up, go to the Preferences menu and select Identification. 

  

 

In the first tab, Main name and address enter the identification information of your firm. 
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User’s Defaults 

The User’s Defaults section is the place where you can choose defaults for all your clients. Through this section, 

you can have DT Max automatically complete certain areas of your clientsô tax returns. Moreover, you can setup 

technical defaults as well, such as your range of client numbers and a verification system. 

In order to access this section, go to the Preferences menu, and select User’s Defaults. 

 

 

The first tab is the Client information tab. Within this tab, you can select the default province of residence, 

language of correspondence for all new clients added to your Client List and the type of trust. 
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In the Tax calculations tab, indicate how you want DT Max to handle the instalment payment calculation.  

 

 

In the Tax Return tab, you can set up fields that DT Max will automatically complete in the clientôs tax return. You 

can also set up your defaults for the authorization forms generated within your clientôs tax return. You can set the 

limit of consent and the level of authorization you want for all your clients.  
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In order to edit the Forms Manager, simply right click at the intersection of the form and the Destination, and 

choose amongst the 3 different options. 

 

Tip: A quick way of editing the Forms Manager is to cancel the printing of 
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Right click in the highlighted area, and select Do not print. 

 

 

Now pick the forms you would like to print by right-clicking at the intersection of the form and the Destination, and 
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It is strongly recommended that you print your Forms Manager setup after you have completed the editing. This 

allows you to have a backup copy of the setup you have performed. 

In order to print your Forms Manager setup, click on Print this list. 

 

 

If you make mistakes editing your Forms Manager, you can always return to DT Maxôs default setup. 

In order to reset your Forms Manager, click on Reset.  

 

 

A new window appears. Select Reset to DT Max defaults. Then click OK. 
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DT MAX ADVANCED FEATURES 

Now that we have seen some basic features of DT Max, we will visit some more advanced features of the program. 

We will breakup these features amongst DT Maxôs three screens and the Preferences menu. 

 

CLIENT LIST 

Filtering the Client List 

DT Max allows you to filter your Client List in order to find specific clients that meet certain criteria. For example, 

you can find your clients that have a testamentary trust
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Days since last activity 

You can filter your Client List based on the days since you have edited your clientsô files. Simply enter a range of 

number of days, for example from 0 to 30 days, to see which clients 
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You can also perform reverse filters with the Keywords section. Simply add an exclamation mark ñ!ò at the front of 

the keyword you enter within this section, and DT Max will exclude the clients that have this keyword in their Data 

Entry. 

 

Calculated Tax Data 

You can filter your Client List based on amounts calculated in the clientôs tax return. For example, you can find 



 

 

44 
 

 

A new window will appear, allowing you to pick any form that DT Max produces and view it on the screen in blank 

format.  

Select the form on which you want to filter a specific field, and click Display. 

 

 

Find the field or line you wish to apply a filter to, then go back to the View menu and select 
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You will notice that field codes will appear within every line of the form you are viewing. You can now either mark 

down the particular field code you need for use within a filter or you can print the form with the field codes showing 

and archive these pages for future reference when filtering.  

 

 

Once you have the field code you need, go back to the Client List, then go to the Tools menu, and select Filter 

the Client List.  
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Choose one of the spare filters to customize and click 
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The field codes have to be entered in a specific format. You must also specify what precisely you are looking for 

within a particular field. For example, for a specific field, you have to specify whether the condition you want is that 

the field is equal to zero, or a field is within a specific range. 

When entering the field code, you must start with the percentage symbol “%”. For example, if the field you marked 

down and you want to filter on was D25:101, it must be entered as such: 

%D25:101 

Having specified the field code, you must now specify the condition, i.e., what are you looking for within this field.  

To specify the condition, you must use mathematical symbols such as: 

>  Greater than 

<  Smaller than 

=  Equal to 

>= Greater than or equal to
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In the Data to extract section, select which years you want to extract. 

 

 

In the bottom portion of the window, you can name and choose the path for which you want to save your extract. 

Click on the Browse button, and choose the path you want to save the extract through Windows Explorer. 
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Merging Clients 

In order to merge a client in your Client List, go to the Tools menu and select Merge. 

 

Windows Explorer will appear, allowing you to locate the client you wish to merge. Select the file and click Open. 

 

 

A new window will appear
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In the Destination section, select whether you want to print or export your Client List. 
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In the Name of file receiving the exported data
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In the window that appears, choose the years and setup files you wish to backup. You can use CTRL + click to 

select which years and setup files you wish to backup.  

Click Next once you have made the appropriate selections. 

 

Tip: It is strongly recommended that you backup all years and settings. 

 

DT Max will now prompt you to save your backup file in a particular location. Click Browse. 

 

Window Explorer will appear, allowing you to choose the location you w
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Restore 

To restore a backup file, go to the Tools 
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Renumbering Clients 

DT Max automatically assigns numbers to every client file you create in the Client List. This number is usually 

shown to the left of the clientôs name. The Client Number is important in order to avoid duplicate files within your 

Client List (see Extracting and Merging Clients section above). 

To change the Client Number of an existing client in your Client List, you must select the client for which you wish 

to change the Client Number. They should appear highlighted in blue in your Client List.  If you wish to change the 

client numbers of several clients, press the Space bar on the names of the clients you wish to renumber. A yellow 

highlight will cover their names in the Client List. 

Once you have selected your clients, go to the Tools menu, select Advanced Utilities, then select Renumber 

Client. 

 

 

A new window appears, allowing you to renumber your clients.  

In the Batch Selection section, choose the clients for which you wish to change the Client Number.  
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Copy from Production: Choose this option if you want to 
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Naming your Plan 

The next step after creating your Plan is to name it. 
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Previous year 

The first option you can choose from the Right-hand side display is the previous year. Click on the drop-down 

menu, and select the previous year. 

 

 

Now all the clientôs prior year Data Entry is displayed in the right-hand side of the screen. 

 

All prior year amounts will match up side by side with the current year amounts as long as the description entered 

for the slip or business statement is the same from one year to the next. 
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Carryforwards from the previous year 

You can display the carryforward amounts from the previous year on the right-hand side. Simply select 

Carryforwards from XXXX on the right-hand side display drop-down menu. 

 

Tip: This option is particularly useful if you accidentally lose the carryforwards within your clientôs Data Entry. You 

can always recover them using this option. 

 

Other Client 

You can also choose to display any other client located in the Client List on the right-hand side. The only 

information you need is the Client Number of the client you wish to display on the right. 

Go to the right-hand side drop-down menu, and select Other Client. 

 

A new window appears. Enter the client number of the client you wish to display on the right. Then choose which 

version of the file you want to see and which year. Click OK. 

 

Now you can see side-by-side the Data Entry of your client with the ñother clientò displayed on the right. 
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Review Tags 

The Review Tags feature allows you to tag a specific keyword entry when you are working in the Data Entry 

screen. To place a review tag simply right-click the relevant keyword entry. A new window will appear. Select Tag 

Keyword “For review”. 

 

 

An exclamation and interrogation mark symbol will appear beside the entry. 

 

 

Once a Review Tag is inputted, DT Max will add a review note in the Error and warning messages section. To 

view these review notes, click on the Error and warning messages icon. 

 

 

In this new window, you will be able to view the list of error and warning messages as well as the review tags.  
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Frequently used Keywords 

Trust  

Use the keyword Trust to indicate the type of trust that was created. Use the drop menu to choose between 

Testamentary trust and Inter vivos trust. 

 

Trust-Type 
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Trustee  

Complete the trusteeôs information by completing the keyword Trustee.   

Enter the last name or the business name of the trustee that holds legal title to property in trust for the benefit of the 
trust beneficiaries. 

 
 

If the trustee is an individual enter the last name in the first keyword of the group followed by the first name. 

 

Beneficiary 

To complete the information of the person who will benefit the trust created use the keyword Beneficiary. The 
beneficiary information will be report
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Allocation  

The allocation of income to the beneficiary is done through the secondary keyword Allocation. In the drop down 
menu choose between the following options:  
 

¶ As per will/trust document  

¶ Preferred beneficiary election 
 

 

 

In the keyword Allocation-Type indicate whether the income to be allocated is a percentage or fixed amount of 
the trustôs income. 
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Specify the type of income in the keyword Income-Type and enter the percentage or fixed amount to be 
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In the Tax Return screen, two additional review tags are available for use. 

 

When tagging a field as ñErrorò, DT Max will highlight the field in red and input an X symbol in the navigator section 

to the left of the screen to indicate that an error is present and must be verified before the final production of the tax 

return. 

  

 

Once the error tag has been verified, you may right-click the field and select Tag: Final check. 

 

 

DT Max will now highlight the field in green and input a double checkmark symbol in the navigator. 

 

 

In addition to the review tags, DT Max also allows you to attach notes to specific fields on the tax return. To add a 

note, right-click the desired field and select Add a review note. 

 

 

A new window will appear allowing you to enter a review note of up to maximum of 400 characters. Once you have 



 

 

71 
 

 

entered the note, click Save. 

  

A yellow note page symbol will appear in the navigator indicating that a review note is present. 

 

Once one or more review notes are no longer required, you may choose to remove them individually or all at once. 

To remove an individual review note, right-click the corresponding field and select Edit the review note.  

 

 

From the Field Review Note window, select Remove this note. 
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To delete all the review notes and tags at once, right-click any field and select Remove ALL review tags from this 

client. 

 

 

PDF 

DT Maxôs PDF function allows you to save selected pages of the tax return as PDF files. These files can be 

archived or even sent in an e-mail directly through DT Max. 

To access this feature, once on the Tax Return screen, click the PDF icon located on the toolbar. 

 

 

A new window will appear. 

To save selected pages of the tax return as PDF files, tick the box next to Save as a PDF file. 

 

 

Once selected, you will be able to browse a save location by click
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you would like to save to PDF or send directly by e-mail. DT Max will only list the relevant pages with regards to 

your client. 

 

Tip: You may choose to select the pages one at a time by holding down CRTL on your keyboard and clicking the 

corresponding pages from the list. 
 
 
 

PREFERENCES MENU 

Security System 

DT Max features a security system which enables you to set up the program so that only authorized personnel are 

allowed to use certain specified attributes. 

When DT Max is first installed, all users can access any program feature as passwords are not required until the 

security system is activated.  

User IDs and passwords are tied to a specific DT Max database. If you use different databases, each database 

mus
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Setting up a supervisor
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Company Database Security Policy setup 

Once you have set up the supervisor, you must now set up the Company Database Security Policy. 

Go to the Preferences menu, select Security System, and then select 
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Restart DT Max. You will now be required to enter your password in the Splash Screen.  

Enter your password in the appropriate box and click Start. 
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A new window appears. Click New to add a user to the database. 

 

 

In the Required user information section, enter the user name and password of the new user you are creating. 
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In the User’s security access and rights section, untick System Supervisor and then untick the rights you want 

to disable for this particular user. 

Click OK once you are done. 

 

 

 

Archiving and PDF 
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A new window will appear with several options. 

 

 

In the When to archive automatically section, you may choose amongst 4 options. Make the appropriate 

selection. 

 

Tip: We strongly recommend to select the ñArchive when all destinations are printed´option. 

 

In the Location of saved archive files section, you may select the location of the base folder where the files will 

be archived. DT Max will implicitly offer you to save the files in a subfolder located in your database folder. 
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You may however choose to manually select a base folder location by ticking the box next to ñSpecify the name 

and location of the base folderò and clicking on the ñbrowseò icon. 

 

Tip: We strongly recommend to keep the ñUse different subfolders for T1, T2, T3ò and ñUse a different 

subfolder for each tax yearò options selected. This will ensure a proper classification and archiving of your client 

files. 

 

In the Naming convention for archive files section, choose amongst the 5 options. This section will determine 

how the files will be named in the archive folder. The file name can be composed of the clientôs name, client 

number. 

 

Tip: We recommend using the ñClient name, client number, business numberò option. 

 
 


